Machine Automation Controller NJ-series

EtherNet/IP™
Connection Guide

OMRON Corporation
FQ2 series Smart Camera
About Intellectual Property Right and Trademarks

Microsoft product screen shots reprinted with permission from Microsoft Corporation. Windows is a registered trademark of Microsoft Corporation in the USA and other countries. ODVA and EtherNet/IP™ are trademarks of ODVA. Sysmac is a trademark or registered trademark of OMRON Corporation in Japan and other countries for OMRON factory automation products. EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH, Germany. Other company names and product names in this document are the trademarks or registered trademarks of their respective companies.
Table of Contents

1. Related Manuals .................................................................1
2. Terms and Definitions .............................................................2
3. Remarks ..............................................................................3
4. Overview ...........................................................................4
5. Applicable Devices and Support Software ..............................5
   5.1. Applicable Devices ..........................................................5
   5.2. Device Configuration .........................................................6
6. EtherNet/IP Settings ...............................................................8
   6.1. EtherNet/IP Communications Settings .............................8
   6.2. Allocation for Tag Data Links ..........................................9
7. Connection Procedure ............................................................13
   7.1. Overview of Setting Tag Data Links ...............................13
   7.2. Work Flow ..................................................................14
   7.3. Setting Up the Smart Camera .......................................15
   7.4. Setting Up the Controller ..............................................28
   7.5. Setting Up the Network ..................................................34
   7.6. Connection Status Check ..............................................38
8. Initialization Method ..............................................................42
   8.1. Controller ...................................................................42
   8.2. Smart Camera .............................................................44
9. Appendix 1 Detailed Settings of the Tag Data Links ..................45
   9.1. Global Variable Table ....................................................45
   9.2. Relationship between Destination Device and Global Variables ....47
   9.3. Associating the Tag Data Links .....................................50
10. Appendix 2 Setting Procedure without the Configuration Files ....51
    10.1. Overview of Setting Procedure without the Configuration Files .....51
    10.2. Work Flow of "Procedure for Setting Parameters from the Beginning" ....52
    10.3. Setting Up the Controller without the Configuration Files ............54
    10.4. Setting Up the Network with Network Configurator .................66
11. Revision History .................................................................76
1. Related Manuals

The table below lists the manuals related to this document. To ensure system safety, make sure to always read and heed the information provided in all Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for each device which is used in the system.

<table>
<thead>
<tr>
<th>Cat. No.</th>
<th>Model</th>
<th>Manual name</th>
</tr>
</thead>
<tbody>
<tr>
<td>W500</td>
<td>NJ501-[]</td>
<td>NJ-series CPU Unit Hardware User's Manual</td>
</tr>
<tr>
<td></td>
<td>NJ301-[]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NJ301-[]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NJ301-[]</td>
<td></td>
</tr>
<tr>
<td>W504</td>
<td>SYSMAC-SE2</td>
<td>Sysmac Studio Version 1 Operation Manual</td>
</tr>
<tr>
<td>Z326</td>
<td>FQ2 series</td>
<td>FQ2 Smart Camera User's Manual</td>
</tr>
</tbody>
</table>
# 2. Terms and Definitions

<table>
<thead>
<tr>
<th>Terms</th>
<th>Explanation and Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag data link</td>
<td>A function that enables cyclic tag data exchanges on an EtherNet/IP network between Controllers or between Controllers and other devices without using a user program in the Controllers.</td>
</tr>
<tr>
<td>Tag</td>
<td>A tag is a unit that is used to exchange data with tag data links. Data is exchanged between the local network variables and remote network variables specified in the tags or between specified I/O memory areas.</td>
</tr>
<tr>
<td>Tag set</td>
<td>When a connection is established, from 1 to 8 tags (including Controller status) is configured as a tag set. Each tag set represents the data that is linked for a tag data link connection.</td>
</tr>
<tr>
<td>Connection</td>
<td>A connection is used to exchange data as a unit within which data synchronicity is maintained. Thus, data concurrency is maintained for all the data exchanged for a tag or multiple tags in one data set.</td>
</tr>
<tr>
<td>Originator and Target</td>
<td>To perform tag data links, one node requests the opening of a communications line called &quot;connection&quot; to exchange data with another node. The node that requests opening the connection is called &quot;originator&quot;, and the node that receives the request is called &quot;target&quot;.</td>
</tr>
<tr>
<td>Node</td>
<td>With an EtherNet/IP network, 1 node is 1 EtherNet/IP port.</td>
</tr>
<tr>
<td>Tag data link parameter</td>
<td>The tag data link parameter is the setting data to perform the tag data link. It includes the data to set tags, tag sets, and connections.</td>
</tr>
<tr>
<td>EDS file</td>
<td>A file that contains the I/O points of EtherNet/IP devices and the parameters that can be set via EtherNet/IP.</td>
</tr>
</tbody>
</table>
3. Remarks

(1) Understand the specifications of devices which are used in the system. Allow some margin for ratings and performance. Provide safety measures, such as installing safety circuit in order to ensure safety and minimize risks of abnormal occurrence.

(2) To ensure system safety, always read and heed the information provided in all Safety Precautions, Precautions for Safe Use, and Precaution for Correct Use of manuals for each device used in the system.

(3) The user is encouraged to confirm the standards and regulations that the system must conform to.

(4) It is prohibited to copy, to reproduce, and to distribute a part of or whole part of this document without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2013. It is subject to change without notice for improvement.

The following notation is used in this document.

- **WARNING**
  Indicates a potentially hazardous situation which, if not avoided, will result in minor or moderate injury, or may result in serious injury or death. Additionally there may be significant property damage.

- **Caution**
  Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury or in property damage.

**Precautions for Safe Use**
Precautions on what to do and what not to do to ensure safe usage of the product.

**Precautions for Correct Use**
Precautions on what to do and what not to do to ensure proper operation and performance.

**Additional Information**
Additional information to read as required.
This information is provided to increase understanding or make operation easier.

**Symbols**

- The filled circle symbol indicates operations that you must do.
- The specific operation is shown in the circle and explained in text.
- This example shows a general precaution for something that you must do.
4. Overview

This document describes the procedure for connecting the Smart Camera (FQ2 series) of OMRON Corporation (hereinafter referred to as OMRON) to the NJ-series Machine Automation Controller (hereinafter referred to as the Controller) on EtherNet/IP and provides the procedure for checking their connection.

Specifically, it describes the procedure for connecting EtherNet/IP using the EtherNet/IP settings of the project file prepared beforehand (hereinafter referred to as the “procedure for using the configuration files”).

Section 9 A-1 and Section 10 A-2 describe the procedures for setting parameters without the prepared configuration files (hereinafter referred to as the “procedure for setting parameters from the beginning”).

To follow the "procedure for using configuration files", obtain the latest "Sysmac Studio project file" and "Network Configurator v3 network configuration file" (hereinafter referred to as "configuration files") from OMRON in advance.

<table>
<thead>
<tr>
<th>Name</th>
<th>File name</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sysmac Studio project file (extension: SMC)</td>
<td>OMRON_FQ2_EIP_EV100.SMC</td>
<td>Ver.1.00</td>
</tr>
<tr>
<td>Network Configurator version 3 network configuration file (extension: NVF)</td>
<td>OMRON_FQ2_EIP_EV100.NVF</td>
<td>Ver.1.00</td>
</tr>
</tbody>
</table>
5. Applicable Devices and Support Software

5.1. Applicable Devices

The applicable devices are as follows:

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Name</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMRON</td>
<td>NJ-series CPU Unit</td>
<td>NJ501-[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NJ301-[]</td>
</tr>
<tr>
<td>OMRON</td>
<td>FQ2 series Smart Camera</td>
<td>FQ2-S10[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FQ2-S15[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FQ2-S20[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FQ2-S25[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FQ2-S30[]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FQ2-S35[]</td>
</tr>
</tbody>
</table>

Precautions for Correct Use

As applicable devices above, the devices with the models and versions listed in Section 5.2 are actually used in this document to describe the procedure for connecting devices and checking the connection.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the above devices with versions not listed in Section 5.2 or versions higher than those listed in Section 5.2, check the differences in the specifications by referring to the manuals before operating the devices.

Additional Information

This document describes the procedure to establish the network connection. Except for the connection procedure, it does not provide information on operation, installation or wiring method. It also does not describe the function or operation of the devices. Refer to the manuals or contact your OMRON representative.
5. Applicable Devices and Support Software

5.2. Device Configuration

The hardware components to reproduce the connection procedure of this document are as follows:

<table>
<thead>
<tr>
<th>Manufacturer</th>
<th>Name</th>
<th>Model</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>OMRON</td>
<td>NJ series CPU Unit (Built-in EtherNet/IP port)</td>
<td>NJ501-1500</td>
<td>Ver.1.03</td>
</tr>
<tr>
<td>OMRON</td>
<td>Power Supply Unit</td>
<td>NJ-PA3001</td>
<td></td>
</tr>
<tr>
<td>OMRON</td>
<td>Switching Hub</td>
<td>W4S1-05C</td>
<td>Ver.1.0</td>
</tr>
<tr>
<td>OMRON</td>
<td>Sysmac Studio</td>
<td>SYSMAC-SE2</td>
<td>Ver.1.04</td>
</tr>
<tr>
<td>OMRON</td>
<td>Network Configurator</td>
<td>(Included in Sysmac Studio.)</td>
<td>Ver.3.53</td>
</tr>
<tr>
<td>OMRON</td>
<td>Sysmac Studio project file</td>
<td>OMRON_FQ2_EIP_EV10_0.SMC</td>
<td>Ver.1.00</td>
</tr>
<tr>
<td>OMRON</td>
<td>Network Configurator version 3 network configuration file</td>
<td>OMRON_FQ2_EIP_EV10_0.NVF</td>
<td>Ver.1.00</td>
</tr>
<tr>
<td></td>
<td>- Personal computer (OS:Windows7)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- USB cable (USB 2.0 type B connector)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>- LAN cable (Ethernet STP (Shielded twisted-pair) cable of category 5 or higher)</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>OMRON</td>
<td>Smart Camera (with a C-mount)</td>
<td>FQ2-S30-13M</td>
<td>Ver.1.61</td>
</tr>
<tr>
<td>OMRON</td>
<td>Camera lens</td>
<td>3Z4S-LE SVZS411</td>
<td></td>
</tr>
<tr>
<td>OMRON</td>
<td>I/O Cable</td>
<td>FQ-WD0111</td>
<td></td>
</tr>
<tr>
<td>OMRON</td>
<td>FQ Ethernet Cable</td>
<td>FQ-WN0111</td>
<td></td>
</tr>
<tr>
<td>OMRON</td>
<td>Touch Finder (Model with AC/DC/battery power supply)</td>
<td>FQ2-D31</td>
<td>Ver.1.60</td>
</tr>
<tr>
<td>OMRON</td>
<td>AC Adapter for Touch Finder (Model with AC/DC/battery power supply)</td>
<td>FQ-AC1</td>
<td></td>
</tr>
</tbody>
</table>

Precautions for Correct Use

To use the configuration files, obtain the latest "Sysmac Studio project file" and "Network Configurator version 3 network configuration file" from OMRON beforehand.
(To obtain the files, contact your OMRON representative.)
**Precautions for Correct Use**

Update the Sysmac Studio to the version specified in this section or higher version using the auto update function.
If a version not specified in this section is used, the procedures described in Section 7 and subsequent sections may not be applicable. In that case, use the equivalent procedures described in the Sysmac Studio Version 1 Operation Manual (Cat.No. W504) and Network Configuratior Online Help.

**Additional Information**

In this document, a USB is used to connect with the Controller. For information on how to install a USB driver, refer to A-1 Driver Installation for Direct USB Cable Connection in the Sysmac Studio Version 1 Operation Manual (Cat.No. W504).
6. EtherNet/IP Settings

This section describes the specifications such as communication parameters and variables that are defined in this document.
Hereinafter, the Smart Camera is referred to as the "destination device" in some descriptions.

6.1. EtherNet/IP Communications Settings

The Controller settings are shown below.

<table>
<thead>
<tr>
<th></th>
<th>Controller (node 1)</th>
<th>Smart Camera (node 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP address setting</td>
<td>-</td>
<td>Fixed</td>
</tr>
<tr>
<td>IP address</td>
<td>192.168.250.1</td>
<td>192.168.250.2</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
<td>255.255.255.0 (Default)</td>
</tr>
<tr>
<td>Gateway</td>
<td>-</td>
<td>10.5.5.1 (Default)</td>
</tr>
<tr>
<td>KeepAlive</td>
<td>Use (Default)</td>
<td>-</td>
</tr>
<tr>
<td>Link data output</td>
<td>-</td>
<td>EtherNet/IP</td>
</tr>
<tr>
<td>Connection type</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Output data size</td>
<td>-</td>
<td>32 bytes (Default)</td>
</tr>
</tbody>
</table>

*In this document, the gateway setting is unnecessary because the connection is made in the same segment.

The Touch Finder settings used in 7.6.2 Checking Data That Are Sent and Received are shown below.

<table>
<thead>
<tr>
<th></th>
<th>Touch Finder (For operation check)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto</td>
<td>OFF (Default)</td>
</tr>
<tr>
<td>IP Address</td>
<td>192.168.250.150</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0 (Default)</td>
</tr>
<tr>
<td>Gateway</td>
<td>10.5.5.1 (Default)</td>
</tr>
<tr>
<td>Display screen</td>
<td>Run</td>
</tr>
</tbody>
</table>

*In this document, the gateway setting is unnecessary because the connection is made in the same segment.
6.2. Allocation for Tag Data Links

6.2.1. Data Types

The following data types are used for the Smart Camera.

- Definition of the data type to access the signals (Union)
  This data type is used to access the control signals and status signals.

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
</tr>
</thead>
<tbody>
<tr>
<td>U_EIPFlag</td>
<td>UNION</td>
</tr>
<tr>
<td>F</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td>W</td>
<td>DWORD</td>
</tr>
</tbody>
</table>

- Definition of the data type to access the command communications area (Structure)
  This data type is used to access the command area

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
<th>Destination device data</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_EIPOutput</td>
<td>STRUCT</td>
<td></td>
</tr>
<tr>
<td>ControlFlag</td>
<td>U_EIPFlag</td>
<td>Control flags (32bit)</td>
</tr>
<tr>
<td>CommandCode</td>
<td>DWORD</td>
<td>Command code (CMD-CODE)</td>
</tr>
<tr>
<td>CommandParam1</td>
<td>UDINT</td>
<td>Command parameter (CMD-PARAM)</td>
</tr>
<tr>
<td>CommandParam2</td>
<td>UDINT</td>
<td></td>
</tr>
<tr>
<td>CommandParam3</td>
<td>DINT</td>
<td></td>
</tr>
</tbody>
</table>

- Definition of the data type to access the response/output areas (Structure)
  This data type is used to access the response/output areas.

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
<th>Destination device data</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_EIPInput</td>
<td>STRUCT</td>
<td></td>
</tr>
<tr>
<td>StatusFlag</td>
<td>U_EIPFlag</td>
<td>Status flags (32bit)</td>
</tr>
<tr>
<td>CommandCodeEcho</td>
<td>DWORD</td>
<td>Command code (CMD-CODE)</td>
</tr>
<tr>
<td>ResponseCode</td>
<td>UDINT</td>
<td>Response code (RES-CODE)</td>
</tr>
<tr>
<td>ResponseData</td>
<td>UDINT</td>
<td>Response data (RES-DATA)</td>
</tr>
<tr>
<td>OutputData</td>
<td>DINT[8]</td>
<td>Output data 0 to 7 (DATA0 to 7)</td>
</tr>
</tbody>
</table>

*1: Output data size

- The data that can be output is determined by the set value of the Output data sizes as follows:

<table>
<thead>
<tr>
<th>Output data size</th>
<th>Destination device data</th>
<th>Base type</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 bytes (Default)</td>
<td>Output data 0 to 7</td>
<td>DINT[8]</td>
</tr>
<tr>
<td>64 bytes</td>
<td>Output data 0 to 15</td>
<td>DINT[16]</td>
</tr>
<tr>
<td>128 bytes</td>
<td>Output data 0 to 31</td>
<td>DINT[32]</td>
</tr>
<tr>
<td>256 bytes</td>
<td>Output data 0 to 63</td>
<td>DINT[64]</td>
</tr>
</tbody>
</table>
Additional Information


6.2.2. Data Allocation

The data in the tag data links of the Smart Camera are allocated to the global variables of the Controller. The relationship between the device data and the global variables is shown below. The following global variables are defined in the "Configuration file".

Output area (Controller → Smart Camera)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Data type</th>
<th>Data size</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIPOutput</td>
<td>S_EIPOutput</td>
<td>20 bytes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Offset (word)</th>
<th>Destination device data</th>
<th>Variable name</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>+0 and +1</td>
<td>Control flags (32 bits) (Data type: U_EIPFlag)</td>
<td>EIPOutput.ControlFlag.F&quot;1</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EIPOutput.ControlFlag.W&quot;1</td>
<td>DWORD</td>
</tr>
<tr>
<td>+2 and +3</td>
<td>Command code (CMD-CODE)</td>
<td>EIPOutput.CommandCode</td>
<td>DWORD</td>
</tr>
<tr>
<td>+4 and +5</td>
<td>Command parameter (CMD-PARAM)</td>
<td>EIPOutput.CommandParam1</td>
<td>UDINT</td>
</tr>
<tr>
<td>+6 and +7</td>
<td></td>
<td>EIPOutput.CommandParam2</td>
<td>UDINT</td>
</tr>
<tr>
<td>+8 and +9</td>
<td></td>
<td>EIPOutput.CommandParam3</td>
<td>DINT</td>
</tr>
</tbody>
</table>

*1: Allocation of Control flags

Allocation of the EIPOutput.ControlFlag.F variable

| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | 23 | 22 | 21 | 20 | 19 | 18 | 17 | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9  | 8  | 7  | 6  | 5  | 4  | 3  | 2  | 1  | 0  |
|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
|    |    |    |    |    |    |    |    | DS | A  |    |    |    |    |    |    | ER |    |    |    |    |    |    |    |    |    |    |    |    | TR |    |    |    |    |
|    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    | IG |    |    |    |

EXE: Control command execution bit: Turn ON this bit to send a specified command to execute
TRIG: Measurement execution bit: Turn ON this bit to start measurement.
ERRCLR: Error clear bit: Turn ON this bit to turn OFF the ERROR signal.
DSA: Data output request bit: Turn ON this bit to request next data output.
### 6. EtherNet/IP Settings

#### Input area (Controller ← Smart Camera)

<table>
<thead>
<tr>
<th>Variable</th>
<th>Data type</th>
<th>Data size</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIPInput</td>
<td>S_EIPInput</td>
<td>48 bytes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Offset (word)</th>
<th>Destination device data</th>
<th>Variable name</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>+0 and +1</td>
<td>Status flags (32 bits)</td>
<td>EIPInput.StatusFlag.F&lt;sup&gt;1&lt;/sup&gt;</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td></td>
<td>(Data type: U_EIPFlag)</td>
<td>EIPInput.StatusFlag.W&lt;sup&gt;1&lt;/sup&gt;</td>
<td>DWORD</td>
</tr>
<tr>
<td>+2 and +3</td>
<td>Command code (CMD-CODE)</td>
<td>EIPInput.CommandCodeEcho</td>
<td>DWORD</td>
</tr>
<tr>
<td>+4 and +5</td>
<td>Response code (RES-CODE)</td>
<td>EIPInput.ResponseCode</td>
<td>UDINT</td>
</tr>
<tr>
<td>+6 and +7</td>
<td>Response data (RES-DATA)</td>
<td>EIPInput.ResponseData</td>
<td>DINT</td>
</tr>
<tr>
<td>+8 and +9</td>
<td>Output data 0(DATA0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+10 and +11</td>
<td>Output data 1(DATA1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+12 and +13</td>
<td>Output data 2(DATA2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+14 and +15</td>
<td>Output data 3(DATA3)</td>
<td>EIPInput.OutputData</td>
<td>DINT[8]&lt;sup&gt;2&lt;/sup&gt;</td>
</tr>
<tr>
<td>+16 and +17</td>
<td>Output data 4(DATA4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+18 and +19</td>
<td>Output data 5(DATA5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+20 and +21</td>
<td>Output data 6(DATA6)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+22 and +23</td>
<td>Output data 7(DATA7)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>1</sup>: Allocation of Status flags

Allocation of the EIPInput.StatusFlag.F variable

| 31 30 29 28 27 26 25 24 23 22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 |
|-------------------------------|---------------------------------|------------------|
| FLG: Control command completion bit: Turns ON when the execution of the command is completed |
| BUSY: Command execution active bit: Turns ON during the execution of the command |
| READY: Ready bit: Turns ON when a command can be executed. |
| OR: Overall judgment bit: Turns ON when the overall judgment result is NG. |
| RUN: RUN mode display bit: Turns ON during RUN mode. |
| ERR: Error bit: Turns ON when an error is detected. |
| GATE: Data output completed bit: Turns ON when data output is completed. |
*2: Output data size

The output data that is specified for the data output method is output.
The data that can be output is determined by the set value of the Output data sizes as follows:

<table>
<thead>
<tr>
<th>Offset (word)</th>
<th>Output data size</th>
<th>Destination device data</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>+8 to +23</td>
<td>32 bytes (Default)</td>
<td>Output data 0 to 7</td>
<td>DINT[8]</td>
</tr>
<tr>
<td>+8 to +39</td>
<td>64 bytes</td>
<td>Output data 0 to 15</td>
<td>DINT[16]</td>
</tr>
<tr>
<td>+8 to +71</td>
<td>128 bytes</td>
<td>Output data 0 to 31</td>
<td>DINT[32]</td>
</tr>
<tr>
<td>+8 to +135</td>
<td>256 bytes</td>
<td>Output data 0 to 63</td>
<td>DINT[64]</td>
</tr>
</tbody>
</table>

**Additional Information**


**Additional Information**

For information on how to set output data items (position, etc.), refer to Setting the Data to Output Automatically after Measurements in 9-2 Outputting Data and Controlling Operation Through EtherNet/IP of 9 Connecting through Ethernet in the FQ2 Smart Camera User's Manual (Cat. No. Z326).

**Additional Information**

With the Sysmac Studio, the data type is expressed as ARRAY[0..2] OF WORD when an array is specified for a data type. However, the data type of an array is simplified in this document (e.g. WORD[3]). It is possible for Sysmac Studio to specify an array as a data type by using each of the following ways.

- ARRAY[0..2] OF WORD
- WORD [3]

In the example above, 3 WORD array elements are secured.
7. Connection Procedure

This section describes how to connect the Controller on the EtherNet/IP network using the "procedure for using configuration files". This document explains the setting procedure of the Controller and Smart Camera from the factory default setting. For the initialization, refer to Section 8 Initialization Method.

7.1. Overview of Setting Tag Data Links

The following figure shows the relationship of processes to perform tag data links using the "procedure for using configuration files".

Precautions for Correct Use

Obtain the latest "Sysmac Studio project file" and "Network Configurator version 3 network configuration file" from OMRON in advance.

(To obtain the files, contact your OMRON representative.)
7.2. Work Flow

Take the following steps to make the tag data link connection settings for EtherNet/IP.

### 7.3 Setting up the Smart Camera

- **7.3.1 Parameter Setting**
  - Set up the Smart Camera.
  - Set the parameters for the Smart Camera.

- **7.3.2 Setting Up the Touch Finder**
  - Change the IP address of the Touch Finder to monitor the Smart Camera.

### 7.4 Setting up the Controller

- **7.4.1 Starting the Sysmac Studio and Importing the Project File**
  - Start the Sysmac Studio, and import the Sysmac Studio project file.

- **7.4.2 Going Online and Transferring Project Data**
  - Connect online with the Sysmac Studio and transfer the project data to the Controller.

### 7.5 Setting up the Network

- **7.5.1 Starting the Network Configurator and Opening the Network Configuration File**
  - Start the Network Configurator and open the Network Configurator version 3 network configuration file.

- **7.5.2 Transferring Tag Data Link Parameters**
  - Go online with the Network Configurator and transfer the tag data link parameters to the Controller.

### 7.6 Checking the Connection Status

- **7.6.1 Checking the Connection Status**
  - Check the connection status of the EtherNet/IP network.

- **7.6.2 Checking Data that are Sent and Received**
  - Confirm that the EtherNet/IP communications are performed normally.
  - Confirm that the correct data are sent and received.
7.3. Setting Up the Smart Camera

Set up the Smart Camera.

**Precautions for Correct Use**

Complete the procedure in 7.3.1 Parameter Setting before moving on to 7.3.2. Setting Up the Touch Finder.

To restart from 7.3.1 Parameter Setting, restore the Controller, Smart Camera and Touch Finder to the factory default setting. For the initialization, refer to 8. Initialization.

### 7.3.1. Parameter Setting

Set the parameters for the Smart Camera.

1. Connect the Switching Hub to the Ethernet Cable Connector on the side of the Smart Camera using the FQ Ethernet Cable.
2. Connect the I/O Cable to the I/O Cable Connector.
3. Connect the 24 VDC power supply to the brown of the I/O Cable, and the GND to the blue of the I/O Cable.
4. Turn ON the 24 VDC power supply.

*In this document, only the power supply lines are wired. Note that so as not to short-circuit the other lines.

*For details on I/O Cable, refer to 2-4 Wiring in the FQ2 Smart Camera User's Manual (Cat. No. Z326).
2 Set up the Smart Camera by using the Touch Finder.

To select a setting item, tap the Touch Finder's touch panel using the touch pen.

Connect the AC Adaptor to the AC power supply connector on the Touch Finder.

Connect the Switching Hub to the Ethernet Connector on the Touch Finder using the LAN Cable.

Turn ON the power supply switch to the Touch Finder.
3 The start screen of the Touch Finder is displayed.

*Select a language at the first startup. In the following example, English is selected.

Start screen of Touch Finder

Language

<table>
<thead>
<tr>
<th>Language</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>日本語</td>
<td></td>
</tr>
<tr>
<td>English</td>
<td></td>
</tr>
<tr>
<td>Deutsch</td>
<td></td>
</tr>
<tr>
<td>Français</td>
<td></td>
</tr>
<tr>
<td>Italiano</td>
<td></td>
</tr>
<tr>
<td>Español</td>
<td></td>
</tr>
</tbody>
</table>

4 Tap the icon on the right button of the Touch Finder Window.

*If “Auto connect” is displayed and the screen on the right is not displayed, tap Auto connect and display this screen.
5. The pop-up menu on the right is displayed. Tap the **Sensor setting**.

6. Tap **Network** on the Sensor settings Menu.

7. Tap **Ethernet** on the Network Menu.

8. Tap **IP address setting** on the Ethernet Menu.

    Tap **Fixed** on the IP address setting Menu.
9. Set the fixed IP address.

Tap **IP Address** on the Ethernet Menu.

Tap each octet on the IP Address Screen. A numeric keypad is displayed. Tap the numeric keypad and enter each octet of the IP address. After entering, tap **OK**.

Set the IP address to 192.168.250.2.

Tap **OK** to complete the IP address setting.
7. Connection Procedure

10 Confirm that the settings are made as follows and tap OK.

- **IP address setting**: Fixed
- **IP address**: 192.168.250.2
- **Subnet mask**: 255.255.255.0

If the dialog box on the right is displayed, tap OK.

Tap Back.
The window in step 6 is displayed again.

11 Tap Data output.
12. **Connection Procedure**

The Data output Menu is displayed. Tap **Link data output**.

On the Link data output Menu, tap **Comm. type**.

On the Comm. type Menu, tap **EtherNet/IP**.

The Link data output Menu is displayed.

Confirm that the following settings are made, and tap **Back**.

- Comm. type: EtherNet/IP
- Output data size: 32 bytes

On the Data output Dialog Box, tap OK.

On the Sensor settings Menu, tap Back. The Setup Menu is displayed again.
14 On the Setup Menu, tap **Test**.

Tap **Save data**.

On the Save data Dialog Box, tap **Yes**.

15 Cycle the power supply to the Smart Camera.

*The new parameters take effect after cycling the power supply.*
### 7.3.2. Setting Up the Touch Finder

Change the IP address of the Touch Finder to monitor the Smart Camera.

1. Tap ![Search icon](image) on the Touch Finder.

![Auto connect interface](image)

2. The TF setting Menu is displayed. Tap **Ethernet**.

![TF settings menu](image)
3 Tap **IP Address** on the Ethernet Menu.

Tap each octet on the IP Address Screen. A numeric keypad is displayed. Tap the numeric keypad and enter each octet of the IP address. After entering, tap **OK**.

Set the IP address to 192.168.250.150.

Tap **OK** to complete the IP address setting.
Confirm that the settings are made as follows and tap **Back**.

- Auto: OFF
- IP address: 192.168.250.150
- Subnet mask: 255.255.255.0

If the dialog box on the right is displayed, tap **Yes**.
5 On the Setup Menu, tap Run.

Tap Switch to Run mode.

If the dialog box on the right is displayed, tap Yes.

Run is displayed on the Touch Finder.

Additional Information
7.4. Setting Up the Controller

Set up the Controller.

7.4.1. Starting the Sysmac Studio and Importing the Project File

Start the Sysmac Studio, and import the Sysmac Studio project file.
Install the Sysmac Studio and USB driver beforehand

1. Connect the LAN cable to the built-in EtherNet/IP port (PORT1) on the Controller, and connect the USB cable to the peripheral (USB) port. Then, connect the personal computer, Smart Camera, Switching Hub and Controller as shown in 5.2. Device Configuration. Turn ON the power supply to the Controller.

2. Start the Sysmac Studio. Click the **Import** Button.

   *If a confirmation dialog for an access right is displayed at start, select to start.

3. The Import File Dialog Box is displayed. Select OMRON_FQ2_EIP_EV100.SMC (Sysmac Studio project file) and click the **Open** Button.

   *Obtain the Sysmac Studio project file from OMRON.
4 The OMRON_FQ2_EIP_EV100 project is displayed. The left pane is called Multiview Explorer, the right pane is called Toolbox and the middle pane is called Edit Pane.

*If an error message is displayed stating "Failed to Load Descendants", change the version of the Sysmac Studio to any version specified in 5.2. Device Configuration.

5 Select **Check All Programs** from the Project Menu.

6 The Build Tab Page is displayed in the Edit Pane. Check that “0 Errors” and “0 Warnings” are displayed.

7 Select **Rebuild Controller** from the Project Menu.

8 Confirm that Check that “0 Errors” and “0 Warnings” are displayed in the Build Tab Page.
7.4.2. Going Online and Transferring the Project Data
Connect online with the Sysmac Studio and transfer the project data to the Controller.

**WARNING**
Always confirm safety at the destination node before you transfer a user program, configuration data, setup data, device variables, or values in memory used for CJ-series Units from the Sysmac Studio.
The devices or machines may perform unexpected operation regardless of the operating mode of the CPU Unit.

1. Select *Change Device* from the Controller Menu.

2. The Change Device Dialog Box is displayed. Confirm that Device and Version are set as shown on the right.

   *If the settings are different, select and set the setting items from the pull-down list

   Click the **OK** Button.

3. If the settings were changed in step 2, the Build Dialog Box is displayed. Click the **Yes** Button.

4. Select *Communications Setup* from the Controller Menu.
5 The Communications Setup Dialog Box is displayed. Select the Direct Connection via USB Option for Connection Type.

Click the OK Button.

6 Select Online from the Controller Menu.

*If a confirmation dialog box shown on the right is displayed, the model or version of the Controller is different from the device setting. Check the model and version of the Controller, correct the device setting of the project file, and repeat the procedure from step 1. Click the OK Button to close the dialog box.
7 A confirmation dialog box is displayed. Click the Yes Button.

*The displayed dialog depends on the status of the Controller used. Click the Yes Button to proceed with the processing.

*The displayed serial ID differs depending on the device.

8 When an online connection is established, a yellow bar is displayed on the top of the Edit Pane.

Additional Information
For details on the online connections to a Controller, refer to Section 5 Going Online with a Controller in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).

9 Select Synchronization from the Controller Menu.
7. Connection Procedure

10 The Synchronization Dialog Box is displayed. Confirm that the data to transfer (NJ501 in the right figure) is selected. Then, click the Transfer to Controller Button.

11 A confirmation dialog is displayed. Click the Yes Button.

A screen stating "Synchronizing" is displayed.

A confirmation dialog is displayed. Click the No Button.

12 Confirm that the synchronized data is displayed with the color specified by “Synchronized”, and confirm that a message is displayed stating "The synchronization process successfully finished". If there is no problem, click the Close Button.

Additional Information

If the synchronization fails, referring to the message that is displayed, please take appropriate action. For details, refer to 10-3 Error Messages for Sysmac Studio Operation in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).
7.5. Setting Up the Network
Set the tag data links for EtherNet/IP.

7.5.1. Starting the Network Configurator and Opening the Network Configuration File
Start up the Network Configurator and open the Network Configurator version 3 network configuration file.

1. Start the Network Configurator.

2. Select Open from the File Menu.

3. The Open Dialog Box is displayed. Select OMRON_FQ2_EIP_EV100.NVF (Network Configurator version 3 network configuration file). Then, click the Open Button.

   *Obtain the Network Configurator version 3 network configuration file from OMRON.

4. The following devices are displayed in the Network Configuration Pane as shown on the right figure.
   IP address of node 1: 192.168.250.1
   IP address of node 2: 192.168.250.2
7.5.2. Transferring the Tag Data Link Parameters

Connect the Network Configurator online and transfer the tag data link parameters to the Controller.

Precautions for Correct Use

Confirm that the LAN cable is connected before proceeding to the following procedure. If it is not connected, turn OFF the power to the devices and then connect the LAN cable.

1. Select **Select Interface - NJ Series USB Port** from the Option Menu.

2. Select **Connect** from the Network Menu.

3. The Select Connect Network Port Dialog Box is displayed. Select **TCP:2** and click the **OK** Button.
4 The Select Connected Network Dialog Box is displayed. Click the OK Button.

5 When an online connection is established normally, the color of the icon shown on the figure changes to blue.

6 Right-click node 1 device on the Network Configuration Pane and select Parameter - Download. The dialog box on the right is displayed. Click the Yes Button.

*If the Controller used is in RUN mode, the List of Device that are executing Dialog Box is displayed. If displayed, click the Download after changed to Program mode Button and proceed to the next step.

Precautions for Correct Use
If an online connection cannot be made to the Controller, check the cable connection. Or, return to step 4 and check the settings such as a connection type and try again.

Additional Information
For details on the online connections to a Controller, refer to 7-2-8 Connecting the Network Configurator to the Network in Section 7 Tag Data Link Functions of the NJ-series CPU Unit Built-in EtherNet/IP Port User's Manual (Cat. No. W506).
7. Connection Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>The tag data link parameters are downloaded from the Network Configurator to the Controller.</td>
</tr>
</tbody>
</table>

8. The dialog box on the right is displayed. Click the **OK** Button.

*If the operating mode was changed in step 6, a confirmation dialog is displayed. Click the **No** Button to remain in the current operating mode.*
7.6. Connection Status Check

Check the connection status of the EtherNet/IP network.

7.6.1. Checking the Connection Status

Check that the EtherNet/IP communications are performed normally.

1. Confirm that the tag data links are normally in operation by checking the LED indicators on the Controller.

   - **Controller**
     LED indicators in normal status:
     - [NET RUN]: Lit green
     - [NET ERR]: Not lit
     - [LINK/ACT]: Flashing yellow (Flashing while packets are being sent and received)

   - **Smart Camera**
     LED indicators in normal status:
     - [ETN]: Flashing orange
     - [BUSY]: Not lit or lit green
     - [OR]: Not lit or lit orange
     - [ERROR]: Not lit

2. Confirm that the tag data links are normally performed by checking the status information on the Device Monitor Window of the Network Configurator.

   Right-click node 1 device icon on the Network Configuration Pane, and select *Monitor.*
3. The dialog box on the right shows the Status 1 Tab Page of the Monitor Device Dialog Box.

When the same items in the right dialog are selected, the data links are normally performed.

4. The dialog on the right shows an example of the error status.

To check the error details, select the Controller Log tab.

5. This is the Controller Log Tab Page.

6. Exit the Network Configurator.
7. Connection Procedure

7.6.2. Checking Data That Are Sent and Received
Confirm that the correct data are sent and received.

⚠️ WARNING
Always confirm safety at the destination node before you transfer a user program, configuration data, setup data, device variables, or values in memory used for CJ-series Units from the Sysmac Studio. The devices or machines may perform unexpected operation regardless of the operating mode of the CPU Unit.

⚠️ Caution
The Smart Camera will start operation if you perform the following procedure. Confirm safety before you perform the procedure. If you cannot confirm safety, complete the check procedure in Section 7.6.1 and do not perform the procedure in this section.
When you perform the check procedure in this section, make sure to complete all the steps and to place the operation in the safe state.

1. Select **Watch Tab Page** from the View Menu.

2. The Watch Tab Page 1 is displayed in the lower section of the Edit Pane.

3. The following names are entered in the Watch Tab Page 1 for monitoring.
   - EIPOutput.ControlFlag.F[0](EXE)
   - EIPOutput.CommandCode
   - EIInput.StatusFlag.F[0](FLG)
   - EIInput.CommandCodeEcho
   - EIInput.ResponseCode

---

*View* | *Insert* | *Project* | *Controller* | *Simulation*
--- | --- | --- | --- | ---
Output Tab Page | Alt+3 |  |  |  
Watch Tab Page | Alt+4 |  |  |  
Cross Reference Tab Page | Alt+5 |  |  |  
Build Tab Page | Alt+6 |  |  |  

---
4. Enter 00101020 in the Modify Column for 
*EIPOutput.CommandCode*.  
(Command code [00101020]: Start Continuous Measurements)

Press the Enter key to set the value. The Online value for *EIPOutput.CommandCode* changes to 00101020.

Click True in the Modify Column for 
*EIPOutput.ControlFlag.F[0](EXE)*.  
The Online Value changes to True.  
(*EIPOutput.ControlFlag.F[0](EXE)*: Control command execution bit)

5. The measurement is completed and OK is displayed on the screen of the Touch Finder.

The values of *EIPInput.StatusFlag.F[0](FLG),EIPInput.CommandCodeEcho* and *EIPInput.ResponseCode* change as follows:
- *EIPInput.StatusFlag.F[0](FLG)*: [TRUE]
- *EIPInput.CommandCodeEcho*: [00101020]  
  (The sent command code is returned.)
- *EIPInput.ResponseCode*: [0]  
  (The execution result of the command (0: OK, -1(FFFFFFFF):NG) is reflected.)
8. Initialization Method

This document explains the setting procedure from the factory default setting. Some settings may not be applicable as described in this document unless you use the devices with the factory default setting.

8.1. Controller

To initialize the Controller, it is necessary to initialize the CPU Unit and EtherNet/IP port. Place in the PROGRAM mode before the initialization.

8.1.1. EtherNet/IP Port

Delete the connection information and tag information that are set for the EtherNet/IP port. Follow the procedure below to set blank connection information and blank tag information and delete them using the Network Configurator.

(1) Deleting connection information

In the Connections Tab Page of the Edit Device Parameters Dialog Box, move all devices registered in the Register Device List to the Unregister Device List by using the UP Button. If a confirmation dialog is displayed when you remove devices from the registration list, click the Yes Button.
(2) Deleting tag information

In the Tag Sets Tab Page of the Edit Parameters Dialog Box, click the **Delete all of unused Tag Sets** Button. Delete tags in both tab pages: In - Consume Tab Pages and Out - Produce Tab Page.

If a confirmation dialog box is displayed when deleting, click the **Yes** Button.

![Image showing the deletion process](image)

(3) Download

Right-click the Controller and select **Parameter - Download** from the menu that is displayed.

![Image showing the download process](image)
8. Initialization Method

8.1.2. CPU Unit

To initialize the settings of the Controller, select **Clear All Memory** from the Controller Menu of the Sysmac Studio.

8.2. Smart Camera

For information on how to initialize the Smart Camera, refer to *Initializing the Sensor and Touch Finder* in 7-11 Functions Related to the System of the FQ2 Smart Camera User's Manual (Cat. No. Z326).
9. Appendix 1 Detailed Settings of the Tag Data Links

This section describes the detailed settings necessary to perform tag data links set in this document.

9.1. Global Variable Table

The Controller accesses the data in the tag data links as global variables. The following are the settings of the global variables. Register a global variable table with the Sysmac Studio.

<table>
<thead>
<tr>
<th>Name</th>
<th>Data type</th>
<th>Network publish</th>
<th>Destination device allocation</th>
</tr>
</thead>
<tbody>
<tr>
<td>EIPOutput</td>
<td>S_EIPOutput</td>
<td>Output</td>
<td>Output data (20Byte)</td>
</tr>
<tr>
<td>EIPInput</td>
<td>S_EIPInput</td>
<td>Input</td>
<td>Input data (48Byte)</td>
</tr>
</tbody>
</table>

9.1.1. Data Types

The following data types are used for the global variables.

- **Definition of the data type to access the signals (Union)**
  This data type is used to access the control signals and status signals.

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
</tr>
</thead>
<tbody>
<tr>
<td>U_EIPFlag</td>
<td>UNION</td>
</tr>
<tr>
<td>F</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td>W</td>
<td>DWORD</td>
</tr>
</tbody>
</table>

- **Definition of the data type to access the command communications area (Structure)**
  This data type is used to access the command area

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
<th>Destination device data</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_EIPOutput</td>
<td>STRUCT</td>
<td>-</td>
</tr>
<tr>
<td>ControlFlag</td>
<td>U_EIPFlag</td>
<td>Control flags (32bit)</td>
</tr>
<tr>
<td>CommandCode</td>
<td>DWORD</td>
<td>Command code (CMD-CODE)</td>
</tr>
<tr>
<td>CommandParam1</td>
<td>UDINT</td>
<td>Command parameter (CMD-PARAM)</td>
</tr>
<tr>
<td>CommandParam2</td>
<td>UDINT</td>
<td></td>
</tr>
<tr>
<td>CommandParam3</td>
<td>DINT</td>
<td></td>
</tr>
</tbody>
</table>
Definition of the data type to access the response/output areas (Structure)

This data type is used to access the response/output areas.

<table>
<thead>
<tr>
<th>Data type name</th>
<th>Base type</th>
<th>Destination device data</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_EIPInput</td>
<td>STRUCT</td>
<td></td>
</tr>
<tr>
<td>StatusFlag</td>
<td>U_EIPFlag</td>
<td>Status flags (32bit)</td>
</tr>
<tr>
<td>CommandCodeEcho</td>
<td>DWORD</td>
<td>Command code (CMD-CODE)</td>
</tr>
<tr>
<td>ResponseCode</td>
<td>UDINT</td>
<td>Response code (RES-CODE)</td>
</tr>
<tr>
<td>ResponseData</td>
<td>UDINT</td>
<td>Response data (RES-DATA)</td>
</tr>
<tr>
<td>OutputData</td>
<td>DINT[8]</td>
<td>Output data 0 to 7 (DATA0 to 7)</td>
</tr>
</tbody>
</table>

*1: Output data size

The data that can be output is determined by the set value of the Output data size setting as follows:

<table>
<thead>
<tr>
<th>Output data size</th>
<th>Destination device data</th>
<th>Base type</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 bytes (Default)</td>
<td>Output data 0 to 7</td>
<td>DINT[8]</td>
</tr>
<tr>
<td>64 bytes</td>
<td>Output data 0 to 15</td>
<td>DINT[16]</td>
</tr>
<tr>
<td>128 bytes</td>
<td>Output data 0 to 31</td>
<td>DINT[32]</td>
</tr>
<tr>
<td>256 bytes</td>
<td>Output data 0 to 63</td>
<td>DINT[64]</td>
</tr>
</tbody>
</table>

Additional Information


Additional Information

With the Sysmac Studio, the data type is expressed as ARRAY[0..2] OF WORD when an array is specified for a data type. However, the data type of an array is simplified in this document (e.g. WORD[3]).

It is possible to set either of the following to specify an array for a data type with the Sysmac Studio.

• ARRAY[0..2] OF WORD
• WORD [3]

In the example above, 3 WORD array elements are secured.
9.2. Relationship between Destination Device and Global Variables

The global variables must be sorted in order of offsets of the destination device when setting the tag data link parameters.

The relationship between the memory allocation (offset) of the destination device and the global variables are shown below.

<table>
<thead>
<tr>
<th>Output area (Controller → Smart Camera)</th>
<th>Destination device data</th>
<th>Variable name</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offset (word)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+0 and +1</td>
<td>Control flags (32 bits)</td>
<td>EIPOutput.ControlFlag.F</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td>(Data type: U_EIPFlag)</td>
<td></td>
<td>EIPOutput.ControlFlag.W</td>
<td>DWORD</td>
</tr>
<tr>
<td>+2 and +3</td>
<td>Command code (CMD-CODE)</td>
<td>EIPOutput.CommandCode</td>
<td>DWORD</td>
</tr>
<tr>
<td>+4 and +5</td>
<td>Command parameter (CMD-PARAM)</td>
<td>EIPOutput.CommandParam1</td>
<td>UDINT</td>
</tr>
<tr>
<td>+6 and +7</td>
<td></td>
<td>EIPOutput.CommandParam2</td>
<td>UDINT</td>
</tr>
<tr>
<td>+8 and +9</td>
<td></td>
<td>EIPOutput.CommandParam3</td>
<td>DINT</td>
</tr>
</tbody>
</table>

*1: Allocation of Control flags

Allocation of the *EIPOutput.ControlFlag.F* variable

| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | 23 | 22 | 21 | 20 | 19 | 18 | 17 | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9  | 8  | 7  | 6  | 5  | 4  | 3  | 2  | 1  | 0  |
|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
|    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |    |

EXE: Control command execution bit: Turn ON this bit to send a specified command to execute

TRIG: Measurement execution bit: Turn ON this bit to start measurement.

ERRCLR: Error clear bit: Turn ON this bit to turn OFF the ERROR signal.

DSA: Data output request bit: Turn ON this bit to request next data output.
### Input area (Controller ← Smart Camera)

<table>
<thead>
<tr>
<th>Offset (word)</th>
<th>Destination device data</th>
<th>Variable name</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>+0 and +1</td>
<td>Status flags (32bit)</td>
<td>EIPInput.StatusFlag.F&lt;sup&gt;*&lt;/sup&gt;¹</td>
<td>BOOL[32]</td>
</tr>
<tr>
<td></td>
<td>(Data type: U_EIPFlag)</td>
<td>EIPInput.StatusFlag.W&lt;sup&gt;*&lt;/sup&gt;¹</td>
<td>DWORD</td>
</tr>
<tr>
<td>+2 and +3</td>
<td>Command code</td>
<td>EIPInput.CommandCodeEcho</td>
<td>DWORD</td>
</tr>
<tr>
<td></td>
<td>(CMD-CODE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+4 and +5</td>
<td>Response code</td>
<td>EIPInput.ResponseCode</td>
<td>UDINT</td>
</tr>
<tr>
<td></td>
<td>(RES-CODE)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+6 and +7</td>
<td>Response data</td>
<td>EIPInput.ResponseData</td>
<td>DINT</td>
</tr>
<tr>
<td></td>
<td>(RES-DATA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+8 and +9</td>
<td>Output data 0(DATA0)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+10 and +11</td>
<td>Output data 1(DATA1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+12 and +13</td>
<td>Output data 2(DATA2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+14 and +15</td>
<td>Output data 3(DATA3)</td>
<td>EIPInput.OutputData</td>
<td>DINT&lt;sup&gt;8&lt;/sup&gt;&lt;sup&gt;²&lt;/sup&gt;</td>
</tr>
<tr>
<td>+16 and +17</td>
<td>Output data 4(DATA4)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+18 and +19</td>
<td>Output data 5(DATA5)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+20 and +21</td>
<td>Output data 6(DATA6)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>+22 and +23</td>
<td>Output data 7(DATA7)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<sup>*</sup>¹: Allocation of Status flags

#### Allocation of the EIPInput.StatusFlag.F variable

| 31 | 30 | 29 | 28 | 27 | 26 | 25 | 24 | 23 | 22 | 21 | 20 | 19 | 18 | 17 | 16 | 15 | 14 | 13 | 12 | 11 | 10 | 9 | 8 | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|----|
|    |    |    |    |    |    |    |    |    |    |    |    | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG | FLG |

- **FLG**: Control command completion bit: Turns ON when the execution of the command is completed.
- **BUSY**: Command execution active bit: Turns ON during the execution of the command.
- **READY**: Ready bit: Turns ON when a command can be executed.
- **OR**: Overall judgment bit: Turns ON when the overall judgment result is NG.
- **RUN**: RUN mode display bit: Turns ON during RUN mode.
- **ERR**: Error bit: Turns ON when an error is detected.
- **GATE**: Data output completed bit: Turns ON when data output is completed.
9. Appendix 1 Detailed Settings of the Tag Data Links

*2: Output data size

The output data that is specified for the data output method is output. The data that can be output is determined by the set value of the Output data size setting as follows:

<table>
<thead>
<tr>
<th>Offset (word)</th>
<th>Output data size</th>
<th>Destination device data</th>
<th>Data type</th>
</tr>
</thead>
<tbody>
<tr>
<td>+8 to +23</td>
<td>32 bytes (Default)</td>
<td>Output data 0 to 7</td>
<td>DINT[8]</td>
</tr>
<tr>
<td>+8 to +39</td>
<td>64 bytes</td>
<td>Output data 0 to 15</td>
<td>DINT[16]</td>
</tr>
<tr>
<td>+8 to +71</td>
<td>128 bytes</td>
<td>Output data 0 to 31</td>
<td>DINT[32]</td>
</tr>
<tr>
<td>+8 to +135</td>
<td>256 bytes</td>
<td>Output data 0 to 63</td>
<td>DINT[64]</td>
</tr>
</tbody>
</table>

Additional Information


Additional Information

For information on how to set output data items (position, etc.), refer to Setting the Data to Output Automatically after Measurements in 9-2 Outputting Data and Controlling Operation Through EtherNet/IP of 9 Connecting through Ethernet in the FQ2 Smart Camera User’s Manual (Cat. No. Z326).
9.3. Associating the Tag Data Links

Tag data link parameters are required to perform tag data links with the destination device. Follow the procedure below to associate the tag data links.

1) Use the Sysmac Studio to define the global variables to publish on the network.
   Store the created global variables in a CSV file to use in the Network Configurator.
2) Read the CSV file (tag list) created in step 1 to the Network Configurator.
3) Install the EDS file of the destination device in the Network Configurator.
4) Make a single tag set that includes the tag lists.
5) Link the tag set with the destination device information and create tag data link parameters.

The numbers shown in the tables below correspond to the steps above.

### Output area (Controller → Smart Camera)

<table>
<thead>
<tr>
<th>Controller setting (Set with Sysmac Studio.)</th>
<th>Tag data link parameter setting (Set with Network Configurator.)</th>
<th>Destination device information (EDS file setting contents)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global variable (Data type)</td>
<td>Tag set: EIPOutput</td>
<td>20 bytes</td>
</tr>
<tr>
<td>EIPOutput</td>
<td></td>
<td>(5)</td>
</tr>
<tr>
<td>S_EIPOutput</td>
<td></td>
<td>← Output_100-[20 Bytes]</td>
</tr>
<tr>
<td>(1)</td>
<td></td>
<td>(3)</td>
</tr>
<tr>
<td>(2)</td>
<td>Tag list</td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td>Tag list</td>
<td></td>
</tr>
</tbody>
</table>

*For details, refer to Section 9.2.

### Input area (Controller ← Smart Camera)

<table>
<thead>
<tr>
<th>Controller setting (Set with Sysmac Studio.)</th>
<th>Tag data link parameter setting (Set with Network Configurator.)</th>
<th>Destination device information (EDS file setting contents)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global variable (Data type)</td>
<td>Tag set: EIPIInput</td>
<td>48 bytes</td>
</tr>
<tr>
<td>EIPIInput</td>
<td></td>
<td>(5)</td>
</tr>
<tr>
<td>S_EIPIInput</td>
<td></td>
<td>← Input_101 - [48 bytes]</td>
</tr>
<tr>
<td>(1)</td>
<td></td>
<td>(3)</td>
</tr>
<tr>
<td>(2)</td>
<td>Tag list</td>
<td></td>
</tr>
<tr>
<td>(4)</td>
<td>Tag list</td>
<td></td>
</tr>
</tbody>
</table>

*For details, refer to Section 9.2.
10. Appendix 2 Setting Procedure without the Configuration Files

This section describes the procedure for setting the Controller without using the configuration files (Procedure for setting parameters from the beginning).
It also describes the procedure for changing the parameters of the configuration files.

10.1. Overview of Setting Procedure without the Configuration Files

The following figure shows the relationship of processes to perform tag data links using the "procedure for setting parameters from the beginning".

Settings made with Sysmac Studio
• Setting parameters (IP address, etc.)
• Setting global variables (name, network setting and task setting, etc.)
• Exporting global variables
• Building
• Settings in the Watch Tab Page

Settings made with Network Configurator
• Uploading network configuration
• Importing CSV file (tag name)
• Tag registration
• Connection setting (associating tags with the EDS file of destination device)

Personal computer

Global variable (CSV file)

Network Configurator

Transferring project data

Controller

Transferring tag data link parameters

Destination device
10.2. Work Flow of "Procedure for Setting Parameters from the Beginning"

Use the following procedures to make connection settings for tag data links of EtherNet/IP using the "procedure for setting parameters from the beginning".

This section describes the detailed procedures for "10.3 Setting up the Controller without the Configuration Files" and "10.4 Setting up the Network with Network Configurator" (in red frames below) without using the "configuration files".

The procedures for 7.3 Setting up the Smart Camera and 7.6 Checking the Connection Status" are the same as for the "procedure for using the configuration files": Refer to the procedures in Section 7.

<table>
<thead>
<tr>
<th>7.3. Setting Up Smart Camera</th>
<th>Set up OMRON Smart Camera.</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.3.1. Parameter Setting</td>
<td>Set the IP address of the Smart Camera.</td>
</tr>
<tr>
<td>7.3.2. Setting Up the Touch Finder</td>
<td>Change the IP address of the Touch Finder to monitor the Smart Camera.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>10.3 Setting up the Controller without the Configuration Files</th>
<th>Set up the Controller using the software.</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.3.1 Starting the Sysmac Studio and Setting the Parameters for the Controller</td>
<td>Start the Sysmac Studio and set the parameters for the Controller.</td>
</tr>
<tr>
<td>10.3.2 Setting the Global Variables</td>
<td>Set the global variables to use for the tag data links.</td>
</tr>
<tr>
<td>10.3.3 Exporting the Global Variables</td>
<td>Export the global variables in a CSV file to use as tags in the Network Configurator.</td>
</tr>
<tr>
<td>10.3.4 Going Online and Transferring the Project Data</td>
<td>Go online with the Sysmac Studio and transfer the project data to the Controller.</td>
</tr>
<tr>
<td>10.3.5 Settings in Watch Tab Page</td>
<td>Make settings in the Watch Tab Page to check data that is sent and received.</td>
</tr>
</tbody>
</table>
10.4 Setting Up the Network with Network Configurator

10.4.1 Starting the Network Configurator and Uploading the Configuration

Set the tag data links for the EtherNet/IP by using the software.

Start the Network Configurator, go online with the Controller, and upload the network configuration.

10.4.2 Importing Files and Registering Tags

Import the CSV file that was saved, and register tags of the originator’s send area and receive area.

10.4.3 Setting the Connections

Associate the tags of the target device with the tags of the originator.

10.4.4 Transferring the Tag Data Link Parameters

Transfer the tag data link parameters that were set to the Controller.

7.6 Checking the Connection Status

7.6.1 Checking the Connection Status

Check the connection status of the EtherNet/IP network.

Confirm that the EtherNet/IP communications are performed normally.

7.6.2 Checking Data that are Sent and Received

Confirm that the correct data are sent and received.
10.3. Setting Up the Controller without the Configuration Files

Set up the Controller using the software.

10.3.1. Starting the Sysmac Studio and Setting the Parameters for the Controller

Start the Sysmac Studio and set the parameters for the Controller.

1. Connect the LAN cable and USB cable to the Controller and turn ON the power supply to the Controller.
   *For details, refer to step 1 in 7.4.1 Starting the Sysmac Studio and Importing the Project File.

2. Start the Sysmac Studio. Click the New Project Button.
   *If a confirmation dialog for an access right is displayed at start, select to start.

3. The Project Properties Dialog Box is displayed.
   *In this document, New Project is set as the project name.
   Confirm that the Category and Device to use are set in the Select Device Field.
   Select 1.03 from the Version pull-down menu.
4 Click the Create Button.

5 The New Project is displayed. The left pane is called Multiview Explorer, the right pane is called Toolbox and the middle pane is called Edit Pane.

6 Double-click Built-in EtherNet/IP Port Settings under Configurations and Setup - Controller Setup in the Multiview Explorer.

7 The Built-in EtherNet/IP Port Settings Tab Page is displayed in the Edit Pane. Click the TCP/IP Settings Button, select the Fixed Setting Option in the IP Address Field, and make the following settings:
   - IP address: 192.168.250.1
   - Subnet mask: 255.255.255.0
   - Keep Alive: Use
10.3.2. Setting Global Variables

Set the global variables to use for the tag data links.

1. Double-click **Data Types** under **Programming - Data** in the Multiview Explorer.

2. Click the **Union** in the Data Types Tab Page.

   - Click a column under Name to enter a new item.
   - Enter **U_EIPFlag** in the Name Column.

3. After entering, right-click and select **Create New Member** from the menu.

4. A new row is added.
   - Type **F** in the Name Column.
   - Enter **BOOL[32]** in the Base Type.
   - *After entering, the base type changes to **ARRAY[0..31] OF BOOL** as shown on the right.

5. In the same way as steps 3 and 4, enter the following data in new columns.
   - **Name**: **W**
   - **Base type**: **DWORD**
10. Appendix 2 Setting Procedure without the Configuration Files

6 Click **Structures**.

Click a column under Name to enter a new item.

Enter `S_EIPOutput` in the Name Column.

7 After entering, right-click and select **Create New Member** from the menu.

A new row is added.

Enter `ControlFlag` in the Name Column.

Enter `U_EIPFlag` in the Base Type Column.

8 Enter the following data in the new columns in the same way as steps 7 and 8.
   - Name: CommandCode  
     Base Type: DWORD
   - Name: CommandParam1  
     Base Type: UDINT
   - Name: CommandParam2  
     Base Type: UDINT
   - Name: CommandParam3  
     Base Type: DINT

*Make sure to sort the member list in order of the offsets shown in 9.2. Relationship between Destination Device and Global Variables.*
After entering, right-click and select **Create New Data Type** from a menu.

Enter **S_EIPInput** in the Name Column.

Enter the following data in the new columns in the same way as steps 7 and 8.
- Name: StatusFlag
  Base type: U_EIPFlag
- Name: CommandCodeEcho
  Base type: DWORD
- Name: ResponseCode
  Base type: UDINT
- Name: ResponseData
  Base type: DINT
- Name: OutputData
  Base type: DINT[8]

Double-click **Global Variables** under **Programming - Data** in the Multiview Explorer.
13 The Global Variables Tab Page is displayed in the Edit Pane. Click a column under Name to enter a new variable. Enter **EIPOutput** in the Name Column. Enter **S_EIPOutput** in the Data Type Column. Select **Output** from the Network Publish Menu.

14 After entering, right-click and select **Create New** from the menu.

15 Enter the following data in the new columns in the same way as step 13.
- **Name**: EIPInput
- **Data type**: S_EIPInput
- **Network Publish**: Input

16 Double-click **Task Settings** under **Configurations and Setup** in the Multiview Explorer. The Task Settings Tab Page is displayed in the Edit Pane. Click the **VAR** Button and then click the **+** Button.
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>Click the Down Button under Variable to be refreshed. The variables set in steps 2 to 5 are displayed. Select <em>EIPOutput</em>.</td>
</tr>
<tr>
<td>18</td>
<td>Click the + Button and select a variable to be refreshed. <em>The data types are displayed automatically, and they do not have to be set.</em> Add all variables set in steps 13 and 15 as shown in the right figure.</td>
</tr>
</tbody>
</table>
10.3.3. Exporting the Global Variable

Export the global variables in a CSV file to use as tags in the Network Configurator.

1. Double-click **Global variables** under **Programming - Data** in the Multiview Explorer.

2. The Global Variables Tab is displayed in the Multiview Explorer. Right-click on the pane and Select **Select All**.

   All the selected variables are highlighted.

3. Select **Export Global Variables - Network Configurator** from the Tools Menu.

4. The Save As Dialog Box is displayed. Enter EIP002 in the File name Field. Click the **Save** Button.
### 10.3.4. Going Online and Transferring the Project Data

Connect online with the Sysmac Studio and transfer the project data to the Controller.

![WARNING]

**WARNING**

Always confirm safety at the destination node before you transfer a user program, configuration data, setup data, device variables, or values in memory used for CJ-series Units from the Sysmac Studio. The devices or machines may perform unexpected operation regardless of the operating mode of the CPU Unit.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select <strong>Check All Programs</strong> from the Project Menu.</td>
</tr>
<tr>
<td>![Build Tab Page]</td>
<td>The Build Tab Page is displayed in the Edit Pane. Check that “0 Errors” and “0 Warnings” are displayed.</td>
</tr>
<tr>
<td>2</td>
<td>Select <strong>Rebuild Controller</strong> from the Project Menu.</td>
</tr>
<tr>
<td>![Build Tab Page]</td>
<td>Check that “0 Errors” and “0 Warnings” are displayed in the Build Tab Page.</td>
</tr>
<tr>
<td>3</td>
<td>Select <strong>Communications Setup</strong> from the Controller Menu.</td>
</tr>
<tr>
<td>![Communications Setup]</td>
<td></td>
</tr>
</tbody>
</table>
6. The Communications Setup Dialog Box is displayed. Select the Direct Connection via USB Option for Connection Type.

Click the OK Button.

7. Select Online from the Controller Menu. A confirmation dialog is displayed. Click the Yes Button.

*The displayed dialog depends on the status of the Controller used. Select the Yes Button to proceed with the processing.

8. When an online connection is established, a yellow bar is displayed on the top of the Edit Pane.

Additional Information

For details on the online connections to a Controller, refer to Section 5 Going Online with a Controller in the Sysmac Studio Version 1.0 Operation Manual (Cat. No. W504).

9. Select Synchronization from the Controller Menu.
10. Appendix 2 Setting Procedure without the Configuration Files

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>The Synchronization Dialog Box is displayed. Check that the data to transfer (NJ501 in the right figure) is selected. Then, click the Transfer to Controller Button.</td>
</tr>
<tr>
<td>11</td>
<td>A confirmation dialog is displayed. Click the Yes Button.</td>
</tr>
<tr>
<td></td>
<td>A screen stating “Synchronizing” is displayed.</td>
</tr>
<tr>
<td></td>
<td>A confirmation dialog is displayed. Click the Yes Button.</td>
</tr>
<tr>
<td>12</td>
<td>Confirm that the synchronized data is displayed with the color specified by “Synchronized”, and that a message is displayed stating “The synchronization process successfully finished”. If there is no problem, click the Close Button.</td>
</tr>
</tbody>
</table>

Additional Information

If the synchronization fails, referring to the message that is displayed, please take appropriate action. For details, refer to 10-3 Error Messages for Sysmac Studio Operation in the Sysmac Studio Version 1 Operation Manual (Cat. No. W504).
10.3.5. Settings in the Watch Tab Page

Make settings in the Watch Tab Page to check data that is sent and received.

1. Select **Watch Tab Page** from the View Menu.

2. The Watch Tab Page 1 is displayed in the lower section of the Edit Pane.

3. Enter the following names to monitor in the Name Columns on the Watch Tab Page 1. To enter a new name, click a cell stating **Input Name**.
   - EIPOutput.ControlFlag.F[0](EXE)
   - EIPOutput.CommandCode
   - EIPInput.StatusFlag.F[0](FLG)
   - EIPInput.CommandCodeEcho
   - EIPInput.ResponseCode

   *The settings are used in 7.6.2. Checking Data That are Sent and Received.*
10.4. Setting Up the Network with Network Configurator

Set the tag data links for the EtherNet/IP by using the software.

**Precautions for Correct Use**

Please confirm that the LAN cable is connected before proceeding to the following steps. If it is not connected, turn OFF the power to the devices, and then connect the LAN cable.

**10.4.1. Starting Network Configurator and Uploading Configuration**

Start the Network Configurator and install the EDS file.

1. Start the Network Configurator.

2. Select **Select Interface - NJ Series USB Port** from the Option Menu.

3. Select **Connect** from the Network Menu.
4 The Select Connect Network Port Dialog Box is displayed. Select TCP:2 and click the OK Button.

5 The Select Connected Network Dialog Box is displayed. Click the OK Button.

Precautions for Correct Use
If an online connection cannot be made to the Controller, check the cable connection. Or, return to step 2 and check the settings such as a connection type and try again.

Additional Information
For details on the online connections to a Controller, refer to 7-2-8 Connecting the Network Configurator to the Network in Section 7 Tag Data Link Functions of the NJ-series CPU Unit Built-in EtherNet/IP Port User's Manual (Cat. No. W506).
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>When an online connection has been established normally, the icon shown on the figure turns blue.</td>
</tr>
<tr>
<td>7</td>
<td>Select <strong>Upload</strong> from the Network Menu to upload the device information on the network.</td>
</tr>
<tr>
<td>8</td>
<td>The dialog box on the right is displayed. Click the <strong>Yes</strong> Button.</td>
</tr>
</tbody>
</table>
| 9    | The Target Device Dialog Box is displayed. Click the **OK** Button.  

*The addresses displayed depend on the environment. Display addresses to connect by using the Add and Edit Button.*
10. Appendix 2 Setting Procedure without the Configuration Files

10. The device parameters are uploaded. When uploading is completed, the dialog on the right is displayed. Click the **OK** Button.

11. After uploading is completed, confirm that the Network Configuration Pane shows the updated IP Addresses of devices.
   - IP address of node 1: 192.168.250.1
   - IP address of node 2: 192.168.250.2

12. Right-click the node 2 device and select **Parameter - Edit**.

13. The Edit Device Parameters Dialog Box is displayed. Confirm that the values are set as follows and click the **OK** Button.
   - Output Size: 20
   - Input Size: 48
10. Appendix 2 Setting Procedure without the Configuration Files

10.4.2. Importing the File and Registering the Tags

Import the CSV file that was saved, and register tags of the originator's send area and receive area.

This section explains the receive settings and send settings of the target node.

1. On the Network Configuration Pane of the Network Configurator, right-click the node 1 device and select **Parameter - Edit**.

2. The Edit Device Parameters Dialog Box is displayed. Click the **To/From File** Button.

3. Select **Import from File**.
4 The Import Tag/Tag Set Dialog Box is displayed. Select EIP002.csv and click the **Open** Button.

*In the Look in Field, specify the folder in which the file is saved in Section 10.3.3. Exporting the Global Variables.

5 The dialog boxes on the right may not be displayed depending on the status of the Controller and the software used. If not displayed, proceed to the next step.

Click the **Yes** Button on the right dialog box.

Click the **Yes** Button on the right dialog box.

6 The Edit Device Parameters Dialog Box is displayed again. Click the Tag Sets Tab.

7 Select the In-Consume Tab. EIPInput and 48Byte are displayed.

8 Select the Out- Produce Tab Page. EIPOutput and 20Byte are displayed.
10.4.3. Setting the Connections

Associate the tags of the target device (that receives the open request) with the tags of the originator (that requests opening).

1. Select the Connections Tab in the Edit Device Parameters Dialog Box. Then, select 192.168.250.2 in the Unregister Device List Field. Click the Down Button that is shown in the dialog.

2. 192.168.250.2 is registered in the Register Device List. Select 192.168.250.2 and click the New Button.

3. The Edit Connection Dialog Box is displayed. Select Consume Data From/Produce Data To from the Connection I/O Type Pull-down Menu. In the same way, set the value listed in the table below in each field of Originator Device and Target Device.
Settings of Connections

<table>
<thead>
<tr>
<th>Originator device</th>
<th>Connection I/O type</th>
<th>Connection Type</th>
<th>Output Tag Set</th>
<th>Connection Type</th>
<th>Input Tag Set</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Consume Data From/Produce Data To</td>
<td>Multi-cast connection</td>
<td>EIPOutput – [20Byte]</td>
<td>Point to Point connection</td>
<td>EIInput – [48Byte]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Target Device</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Output Tag Set</td>
<td></td>
<td></td>
<td></td>
<td>Input_101 – [48Byte]</td>
</tr>
<tr>
<td></td>
<td>Input Tag Set</td>
<td></td>
<td></td>
<td></td>
<td>Output_100 – [20Byte]</td>
</tr>
</tbody>
</table>

4. Confirm that settings are correct and click the **Regist** Button.

5. The Edit Connection Dialog Box is displayed. Do not make any setting and click the **Close** Button.
6 The Edit Device Parameters Dialog Box is displayed again. Click the **OK** Button.

7 When the connection setting is completed, the node address is displayed under the device icon on the Network Configuration Pane.
10.4.4. Transferring Tag Data Link Parameters

Transfer the tag data link parameters that were set to the Controller.

1. Right-click node 1 device on the Network Configuration Pane and select **Parameter - Download**.

   ![](image.png)

   The dialog on the right is displayed. Click the **Yes** Button.

   *The List of Devices that are executing Dialog Box is displayed if the Controller used is in RUN mode. If displayed, click the **Download after changed to Program mode** Button and proceed to the next step.*

2. The tag data link parameters are downloaded from the Network Configurator to the Controller.

3. The dialog box on the right is displayed. Click the **OK** Button.

   *If the operating mode was changed in step 1, a confirmation dialog box is displayed. Click the **NO** Button to remain in the current operating mode.*
11. Revision History

<table>
<thead>
<tr>
<th>Revision code</th>
<th>Date of revision</th>
<th>Revision reason and revision page</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>Jul. 18, 2013</td>
<td>First edition</td>
</tr>
</tbody>
</table>